The Decennial I.B.E.A.M.

prepared by
Jerome M. Garrett
Dhritiman Saha
Objectives

- What is IBEAM?
- What are the benefits of IBEAM?
- What has been done to date?
- Where can IBEAM fit into the Decennial 2010 programs?
- What is the future of IBEAM?

We will address these and any other questions you have.
What is IBEAM?

- Information Base for Exchange Administration & Management
- IBEAM centralizes questionnaire content, design information and data capture requirements.
- IBEAM tools are based on business requirements and drivers
- IBEAM helps automates the form design process
- IBEAM can be used for any mode (Paper, Internet, IVR & HHC, CATI, CAPI)
- IBEAM can provide significant support for the 2010 Census
- IBEAM is evolving to meet Census needs
IBEAM’s Vision for Decennial

Provide a system of flexible, integrated and secure tools for the controlled disciplined development and maintenance of paper, Internet, IVR and HHC Census forms with consistency, standardization, efficiency, and better internal communication, in support of CMM.

“Get your work done & get metadata for free”
What we’ve heard….

**Challenge**

- Handle Changes

**Drivers**

**must be able to …**
- Easily try new concepts
- Assess the impact of changes
- Incorporate changes quickly
- Reduce risk

**Decennial**
What we’ve heard….

**Drivers**

*must be able to …*

- Centralize information for better analysis
- Define once and reuse many times
- Eliminate transcription for paper design
- Reduce paper design time
- Improve hand-offs b/w program areas

**Challenge**

- Handle Changes
- Improve Efficiency

**Decennial**
What we’ve heard....

**Challenge**
- Handle Changes
- Improve Efficiency
- Improve Communication & Control

**Decennial**

**Drivers**
- must be able to ...
  - Easily share information
  - Easily exchange information
  - Flow accurate information
  - Just in time information
  - Automatic Notification
  - Better collaboration
Robust infrastructure....

The Decennial IBEAM provides the infrastructure to support a multi-faceted program.
IBEAM Process Overview

Questionnaire Content and Design Specification

Design Control Center

Data Capture & Processing
General Functionality of Content Maintenance

- Maintain questionnaire content
- Print Content Report
- Preview Content
- Analyze Impact of Question changes
- Version a Form or a Question
- View Version History of a Question or Form
- Copying a Question, Group or Form
- Spell check and validate content
- Submit content to Design (ACSD)

Benefits

- Handle Changes
- Improve Efficiency
- Improve Communication
- Improve Control

Implementing a standard, consistent, approach i.e. CMM
**High Level - Questionnaire Development**

Contains form ID info & info which appears on the printed form.

All groupings of questions appear on this screen.

* = Mandatory
Mid Level - Group Development

Contains group info.

Group Title appears on printed form.

Questions in the group appear on this screen.

Question # and order are set on this screen.

User can see entire text for a question.

* = Mandatory
**Detail Level – Question Development**

Contains question info

Responses & Instructions appear on this screen.

Attributes of Response cells are maintained here.

* = Mandatory
**Question No.**: Y4-P2

- **Category**: AGE

```
<B>What is this person’s age and what is this person’s date of birth? </B>
```

* = Mandatory

The Report menu pick has an option for a detailed report on the selected question.
View Question Report - cont’d

The report can be used to confirm content with team members.

<table>
<thead>
<tr>
<th>Question No:</th>
<th>Version</th>
<th>Category</th>
<th>Text:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;B&gt;4</td>
<td>I</td>
<td>AGE</td>
<td>What is this person’s age and what is this person’s date of birth? &lt;/B&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Type</th>
<th>Seq</th>
<th>Inst/Label</th>
<th>Org</th>
<th>Field</th>
<th>Format</th>
<th>Data Type</th>
<th>Count</th>
<th>HSize</th>
<th>VSize</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;B&gt;Print numbers in boxes&lt;/B&gt;</td>
<td>I</td>
<td>10</td>
<td></td>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center above BOTH age and DOB!</td>
<td>R</td>
<td>20</td>
<td></td>
<td>V</td>
<td>P2_AGE</td>
<td></td>
<td>B</td>
<td>N</td>
<td>5</td>
<td>.2</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>30</td>
<td></td>
<td>H</td>
<td>P2DOB_MONTH</td>
<td></td>
<td>B</td>
<td>N</td>
<td>2</td>
<td>.2</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>40</td>
<td></td>
<td>H</td>
<td>P2DOB_DAY</td>
<td></td>
<td>B</td>
<td>N</td>
<td>2</td>
<td>.2</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>50</td>
<td></td>
<td>H</td>
<td>P2DOB_YEAR</td>
<td></td>
<td>B</td>
<td>N</td>
<td>4</td>
<td>.2</td>
</tr>
<tr>
<td>&lt;B&gt;NOTE: Please answer BOTH Questions 5 and 6.&lt;/B&gt;</td>
<td>I</td>
<td>60</td>
<td></td>
<td>V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Preview Question

The Preview menu pick has an option to give the user an idea of what the question will look like.

#### Question Text

- **What is this person’s age and what is this person’s date of birth?**

#### Question Instruction

- Additional instruction information to assist respondent

#### Response Fields

<table>
<thead>
<tr>
<th>Type</th>
<th>Seq</th>
<th>Text (Label/Instruction)</th>
<th>Org.</th>
<th>Field</th>
<th>Format</th>
<th>Data Type</th>
<th>Count</th>
<th>Size</th>
<th>V. Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>20</td>
<td><strong>Age</strong> (on April 1, 2004)</td>
<td>Vertical</td>
<td>P2_AGE</td>
<td>SEGMENTE</td>
<td>NUMERIC</td>
<td>3</td>
<td>2</td>
<td>.22</td>
</tr>
<tr>
<td>R</td>
<td>30</td>
<td><strong>Month</strong></td>
<td>Vertical</td>
<td>P2_DOB_MONTH</td>
<td>SEGMENTE</td>
<td>NUMERIC</td>
<td>2</td>
<td>2</td>
<td>.22</td>
</tr>
<tr>
<td>R</td>
<td>40</td>
<td><strong>Day</strong></td>
<td>Vertical</td>
<td>P2_DOB_DAY</td>
<td>SEGMENTE</td>
<td>NUMERIC</td>
<td>2</td>
<td>2</td>
<td>.22</td>
</tr>
<tr>
<td>R</td>
<td>50</td>
<td><strong>Year of Birth</strong></td>
<td>Horizontal</td>
<td>P2_DOB_YEAR</td>
<td>SEGMENTE</td>
<td>NUMERIC</td>
<td>4</td>
<td>2</td>
<td>.22</td>
</tr>
<tr>
<td>R</td>
<td>60</td>
<td><strong>NOTE: Please answer BOTH Q</strong></td>
<td>Horizontal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Print numbers in boxes.**
4. What is this person's age and what is this person's date of birth?

Print numbers in boxes.

<table>
<thead>
<tr>
<th>Age (on April 1, 2004)</th>
<th>Month</th>
<th>Day</th>
<th>Year of Birth</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2</td>
<td>2</td>
<td>4</td>
</tr>
</tbody>
</table>

NOTE: Please answer BOTH Questions 5 and 6.
By using the questionnaire maintenance screen and the preview option, a user can see how the question looks with the responses aligned horizontally....
### Editing with Preview – cont’d

**Question Maintenance**

<table>
<thead>
<tr>
<th>Form No.</th>
<th>Version</th>
<th>Purpose</th>
<th>Group Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSD-BBB-2</td>
<td>Version 1</td>
<td>Demo Functionality using copy of 2004 DB1 version</td>
<td>Person 4</td>
</tr>
</tbody>
</table>

**Question text No.**

**How much disk space do you have?**

- [ ] 0-1 GB
- [ ] 2-5 GB

**Example:**

```
0.1 GB
```

**Additional instruction information to assist respondent:**

This is the official form for all the people at this address. It is quick, easy, and your answers are protected by law.

**Response label:**

... and also see how it looks with the response cells aligned vertically. This gives the user increased flexibility and the freedom to experiment more without involving the design area.
Question Impact

The Tools menu pick has an option to tell the user if a change to a question will impact other forms.

### Details (Responses/Instruction Items)

<table>
<thead>
<tr>
<th>Type</th>
<th>Seq</th>
<th>Text (Label/Instruction)</th>
<th>Org.</th>
<th>Field</th>
<th>Format</th>
<th>Data Type</th>
<th>Count</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>20</td>
<td>Print numbers in boxes.</td>
<td>Vertical</td>
<td>P2_AGE</td>
<td>SEGMENT</td>
<td>NUMERIC</td>
<td>3</td>
<td>2.22</td>
</tr>
<tr>
<td>R</td>
<td>30</td>
<td>Print numbers in boxes.</td>
<td>Vertical</td>
<td>P2_DOB_MONTH</td>
<td>SEGMENT</td>
<td>NUMERIC</td>
<td>2</td>
<td>2.22</td>
</tr>
<tr>
<td>R</td>
<td>40</td>
<td>Print numbers in boxes.</td>
<td>Vertical</td>
<td>P2_DOB_DAY</td>
<td>SEGMENT</td>
<td>NUMERIC</td>
<td>2</td>
<td>2.22</td>
</tr>
<tr>
<td>R</td>
<td>50</td>
<td>Print numbers in boxes.</td>
<td>Vertical</td>
<td>P2_DOB_YEAR</td>
<td>SEGMENT</td>
<td>NUMERIC</td>
<td>4</td>
<td>2.22</td>
</tr>
</tbody>
</table>

<NOTE: Please answer BOTH Q:

Place text a
Question Impact – cont’d

This question is used on four forms. In fact, on the ACS-1 form the question is used in multiple groups.
The Tools menu pick has an option to show the history of versions for a question.
Version History – cont’d

Notice, version 11 is not displayed in the list because it has been placed on this form.

Hitting the Apply button will add any of the other versions to this form.
The Tools menu pick has an option to copy a question from another group or form.
Copy Question – cont’d

Simply identify the question you wish to copy and it is copied to the target group.
The File menu pick has an option to submit the content to ACSD. ACSD and other designated staff receive a mail message when a form is submitted for design.
ACSD goes to this screen to ‘checkout’ the submitted form for design.

Checkout copies all content from the form to the ACSD designer.

When form is checked out to ACSD designees receive email notification.
IBEAM Process Overview

Questionnaire
Content and Design Specification

Design Control Center

Data Capture & Processing
ACSD uses Amgraf’s One Form Designer Plus (OFDP)

- ACSD imports the content into OFDP.
- ACSD configures OFDP using the design specifications.
- Checkboxes and segment boxes are automatically drawn during import.
- The coordinates of each response cell are automatically captured.
- Various checks are done to verify content integrity.
- Saves the designed form into IBEAM.

Benefits

- Handle Changes
- Improve Efficiency
- Improve Communication
- Improve Control

Implementing a standard, consistent, approach i.e. ..CMM
Form Design in OFDP

Using OFDP, ACSD designs the form by importing the content stored in IBEAM, including the response fields.
IBEAM Process Overview

Questionnaire Content and Design Specification

Design Control Center

Data Capture & Processing
General Functionality of KFI specification

- Define KFI specification as form is developed
- View the impact of form content modification
- Accept the new and modified form content to be part of KFI
- View KFI specification
- Publish KFI specification
- Version a KFI specification
- Define edit rules for response fields

Benefits
- Handle Changes
- Improve Efficiency
- Improve Communication
- Improve Control

Implementing a standard, consistent, approach i.e. CMM
Data Capture

DSCMO goes to this screen to download a coordinate file for the Key From Image (KFI) system.
### KFI Specification

**Form No.** | **Enum. Method** | **Form No.** | **Form Version** | **Purpose** | **KFI Version** | **Last Published** | **Action**
---|---|---|---|---|---|---|---
N 2009 | Island Areas | SSD-BBB-1 | 1 | Test Form for Demo - N | 1 | | View | Publish
N 2005 | Mailout-Mailback | DC-1 | 1 | Census 2004 Site Test | 1 | | View | Publish
N 2005 | Enumerator | DC-15A | 1 | Enumeration of Shelters | 1 | | View | Publish
N 2004 | Mailout-Mailback | DB-1 | 2 | Census 2004 Site Test | 1 | | View | Publish
N 2004 | Mailout-Mailback | DB-1(A) | 1 | Census 2004 Site Test | 1 | | View | Publish
N 2004 | Enumerator | DB-3 | 1 | To obtain coverage and | 1 | | View | Publish
N 2004 | Mailout-Mailback | TEST1 | 1 | Test Questionnaire | 1 | | View | Publish
N 2003 | Mailout-Mailback | 1st Copy of DW1 | 1 | This is a test | 1 | | View | Publish
N 2003 | Mailout-Mailback | 2nd Copy of DW1 | 1 | This is a test | 1 | | View | Publish
N 2003 | Be Counted | A1 | 1 | Questionnaire Creation | 1 | | View | Publish
N 2003 | Mailout-Mailback | ACS-1 | 1 | Questionnaire planned | 1 | | View | Publish
N 2003 | Mailout-Mailback | ACS-1(2003) | 1 | Intended to replace the | 1 | | View | Publish
<table>
<thead>
<tr>
<th>Group/Question</th>
<th>Field Name</th>
<th>Edit Code/Type/Description</th>
<th>Field Length (LL - TL)</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOMB-HH/HH Coverage</td>
<td>HH_RES_NO</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>HH_RES_YES</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>08-OCT-03</td>
<td>HH_RES_WI</td>
<td>030-S,ALPHANUMERIC</td>
<td>2 A-Z</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Please enter all alphanumeric.</td>
</tr>
<tr>
<td>MOMB-HH/Phone Number</td>
<td>HH_PHONE_AREA</td>
<td>..</td>
<td>3</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>HH_PHONE_PREFIX</td>
<td>050-S,NUMERIC</td>
<td>3</td>
<td>1-10</td>
</tr>
<tr>
<td></td>
<td>HH_PHONE_SUFFIX</td>
<td>..</td>
<td>4</td>
<td>-</td>
</tr>
<tr>
<td>MOMB-HH/Tenure</td>
<td>HH_OWN_MORTGAGE</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>HH_OWN_FREECLR</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>HH_OWN_RENTED</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>HH_OWN_NORENT</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>MOMB-HH/Total Pop</td>
<td>HH_POP</td>
<td>..</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td>MOMB-P1/AGE</td>
<td>P1_AGE</td>
<td>..</td>
<td>3</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_DOB_MONTH</td>
<td>..</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_DOB_DAY</td>
<td>..</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_DOB_YEAR</td>
<td>..</td>
<td>4</td>
<td>-</td>
</tr>
<tr>
<td>MOMB-P1/Coverage</td>
<td>P1_RES_NO</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_YOTHERPL</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_COLLEGE</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_SEASONAL</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_WORK</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_CHILDSTY</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>P1_RES_YEOSTHER</td>
<td>..</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>MOMB-P1/NAME</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**KFI Specification cont’d**

DSCMO can edit fields to enter Edit codes, or accept fields when they appear to be complete.

DSCMO can only publish the spec when all fields have been Accepted.

DSCMO can begin work on the spec, before the form is final.

<table>
<thead>
<tr>
<th>KFI Status</th>
<th>Name</th>
<th>Size</th>
<th>Code</th>
<th>Description</th>
<th>Type</th>
<th>LL</th>
<th>UL</th>
<th>Ditto</th>
<th>Procedure</th>
<th>Accept</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Reviewed</td>
<td>HH_RES_NO</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Reviewed</td>
<td>HH_RES_YES</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accepted</td>
<td>HH_RES_WV</td>
<td>2</td>
<td>030</td>
<td>ALPHANUMERIC</td>
<td>S</td>
<td>A</td>
<td>Z</td>
<td></td>
<td>Pleas enter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Reviewed</td>
<td>HH_PHONE_AREA</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edited</td>
<td>HH_PHONE_PREFIX</td>
<td>3</td>
<td>050</td>
<td>NUMERIC EDIT</td>
<td>S</td>
<td>1</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Reviewed</td>
<td>HH_PHONE_SUFFIX</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Reviewed</td>
<td>HH_OWN_MORTGAGE</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Reviewed</td>
<td>HH_OWN_FREECLR</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### IBEAM Current Benefits
(Paper Form ONLY)

**Business Value**

<table>
<thead>
<tr>
<th>Handle Changes</th>
<th>Improve Efficiency</th>
<th>Improve Communication &amp; Control</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content Definition</strong></td>
<td><strong>Form Design</strong></td>
<td><strong>Data Capture &amp; Processing</strong></td>
</tr>
</tbody>
</table>
| • Run Reports  
• Preview Form  
• Impact analysis | • Define Form  
• Define Question  
• Define Responses  
• Spell Check  
• Copy/Version Form  
• Copy/Version Group  
• Copy /Version Question | • Submit  
• Lock/Unlock  
• Automatic Workflow  
• OFDP Import  
• OFDP synchronization  
• OFDP export  
• OFDPOFDP Synchronization | • Check out  
• Check in  
• Validate Design  
• with content  
• Creation of  
• Coordinates | • Validate design  
• with Content | • Locking  
• Accepting  
• Publishing |

**IBEAM is a solution and infrastructure**

- Handle Changes
- Improve Efficiency
- Improve Communication & Control

**Form Design**

- **OFDP Synchronization**
  - Run reports
  - Define Templates
  - Use Design specs
  - OFDP Import
  - OFDP synchronization
  - OFDP export
  - Check out
  - Check in

- **Preview**
  - OFDP Synchronization Log
  - Validate Design
  - with content
  - Creation of
  - Coordinates

- **Data Capture & Processing**
  - Run Reports
  - Re-Publish KFI
  - View changes
  - Copy/Version KFI
  - Accepting
  - Reviewing
  - Define KFI Specs
  - Define Edit code
  - Version KFI specs.
  - Reuse Response Field
  - View KFI spec.
Summary of Benefits

- Improves individual processes
- Eases integration between BOC areas
- Improves communication ....

Questionnaire Content and Design Specification

DMD

Design Control Center

ACSD

Data Capture & Processing

DSCMO
IBEAM Future Possible Benefits

- Content Maintenance for electronic modes
  - All content maintenance features of paper forms apply to electronic modes (IE., copy, security, versioning, etc.)
  - Business Rules, Skip Patterns
  - Instrument Specification Testing
  - Instrument Analysis
  - Instrument Output to Programming
- Variable Maintenance
- Record Layout Maintenance
IBEAM Future Process Overview

(Just one example of IBEAM’s benefit)

Define Questionnaire
Content & Specification (all electronic modes)

Visually/Graphically test the Specification /Paths (all electronic modes)

Store Test Results

Screen Rules
Tested Specification
Include Files
Test Scripts/Data
Generate Code (optionally)

Developing the Instrument (All electronic modes)

Testing the Instrument (All electronic modes)

Compare

Testing the Instrument (All electronic modes)
Instrument Specification Testing (Concept only)

It is possible to generate the 'START_A' screen similar to this from Form content.

The user can enter information and press the Next button to go to the next screen.

This allows the user to verify the Skip Pattern attributes.
Instrument Specification Testing (Concept only)

The 'FIRST' screen is reached from the 'START_A' screen.
Instrument Specification Testing (Concept only)

The 'SECOND' screen is reached from the 'FIRST' screen.
Instrument Specification Testing (Concept only)

The ‘THIRD’ screen is reached from the ‘SECOND’ screen.

To verify computed fields and other fields the user can expose the values of variables at any point in specification testing.
The 'FOURTH' screen is reached from the 'THIRD' screen.

Once again Variables can be exposed to verify accuracy of the specification.
Instrument Specification Testing (Concept only)
(Alternative Look)

Emulation software can also be used to approximate the appearance of the content on hand held computers.

The content can be fed from the IBEAM into the emulation software to provide the user with quick results.
## IBEAM Future Benefits (For all Modes)

### Business Value
- **Handle Changes**
- **Improve Efficiency**
- **Improve Communication & Control**

### Content Definition
- **Run Reports**
- **Preview Form**
- **Impact analysis**
- **Copy/Version Form**
- **Copy /Version Group**
- **Copy /Version Question**
- **Define Form**
- **Define Question**
- **Define Responses**
- **Spell Check**
- **Copy/Version Form**
- **Copy/Version Group**
- **Copy /Version Question**
- **Preview all levels**
- **Submit**
- **Lock/Unlock**
- **Automatic Workflow**

### Form Design
- **OFDP Synchronization**
- **Run reports**
- **Define Templates**
- **Use Design specs**
- **OFDP Import**
- **OFDP synchronization**
- **OFDP export**
- **Check out**
- **Check in**
- **Validate Design with content**
- **Creation of Coordinates**
- **Validate design with Content**

### Data Capture & Processing
- **Run Reports**
- **Preview**
- **OFDP Synchronization Log**
- **Validate Design with content**
- **Creation of Coordinates**
- **Validate design with Content**
- **Lock/Unlock**
- **Automatic Workflow**

### Additional Functionality for Internet, IVR and HHC
- **Define skip patterns**
- **Define validation rules**
- **Define variables**
- **Generate source code**
- **Generate path information**
- **Test Spec Paths early**
- **Step thru Spec to check vars**
- **Generate specs**
- **Define Record layout (RL)**
- **Define Edit & Screen rules**
- **Generate Test Data**
- **Analyze impact on RLs**
- **Accept/Review RLs**
- **Analyze impact on variables**
- **Analyze across all modes**
- **More to be determined**
Questionnaire Functionality under consideration for 2005 Test

<table>
<thead>
<tr>
<th>Function</th>
<th>Mode</th>
<th>Paper</th>
<th>Internet</th>
<th>IVR</th>
<th>CATI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Definition/Editing</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Content Copy, Version, Impact</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Definition of Response Fields</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Association of Response Fields</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Definition of Skips, Screen Rules</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Output Paper Form Coordinates</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition of Capture Spec.</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition of Content Output</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Specification Testing/Debugging</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Output Synchronization</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

CATI operation may be replaced by use of paper forms at call centers.
# Questionnaire Functionality under consideration for 2006 Test

<table>
<thead>
<tr>
<th>Function</th>
<th>Mode</th>
<th>Paper</th>
<th>Internet</th>
<th>IVR</th>
<th>CATI</th>
<th>HHC</th>
<th>CAPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Definition/Editing</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Content Copy, Version, Impact</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Definition of Response Fields</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Association of Response Fields</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Definition of Skips, Screen Rules</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Output Paper Form Coordinates</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition of Capture Spec.</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition of Content Output</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Specification Testing/Debugging</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Output Synchronization</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
IBEAM unites all interview modes – consistency, efficiency and normalization
Questions?

Jerome M. Garrett
Metadata Staff
System Support Division
763 - 6624